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About This Guide
This guide provides a step-by-step introduction to the Micro Focus Rumba Screen Designer.

This guide shows you how to:

• Create a history file
• Use the Rumba Screen Designer to customize a set of screens
• Test the customized screens
• Use the customized screens in the Rumba Desktop.

In addition, there is a comprehensive reference section with further information about designing screens
and information about exporting customized screens to Rumba+ Web and Rumba+ Mobile.

Who should read this guide
This guide is intended to be read by all those interested in customizing green screen applications to create
applications with a modern look and feel.

It is expected that readers would mostly be system administrators or other IT personnel with a similar level
of expertise.

Prerequisites
• Rumba Desktop 9.2
• Rumba+ Build Tool for export to Rumba+ Mobile and Rumba+ Web

Accompanying files
The package containing this document also contains the following files:

• WebFrame_URL.txt

• welcome.jpg

If you do not have these files, you will not be able to complete the exercises for the WebFrame and Image
controls.
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Introduction
You use the Screen Designer to provide a modern look and feel to green screen applications and make
them easier to use. You do this without touching the application code.

This guide provides instructions for you to start using the Screen Designer to customize green screens.

Note: For the purposes of this user guide, only 3270 mainframe screens are used. However, you can
also use the same principles to customize 5250 AS/400 (iSeries) screens.

Terminology
Screen Designer

The customization engine of Rumba+. It consists of two parts:
Screen Design
Used to add static controls on top of specific screens.

Rule Manager
Used to add dynamic or conditional controls which target an entire green screen
application.

Control
A modern visual element that interacts with a green screen.

Rule
An automatic mechanism that creates one or more controls on one or several screens,
with functions defined by conditions.

How it works
The figure below provides an overview of what you do to create and use customized screens:
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Architecture
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Getting Started
In this section, you:

• Extract the files that came with this document.
• Start a mainframe session.
• Change the color of the screen text to make it more visible.
• Connect to the Rumba Demo Host.

Extracting the package files
Extract the WebFrame_URL.txt and welcome.jpg files from the package .ZIP file to your local
machine. Make a note of where you save them as you will need them later.

Starting a mainframe session
1. From the Windows Start menu, select: 

Start > All Programs > Micro Focus Rumba > Micro Focus Rumba Desktop

The Welcome screen appears:

2. Click Mainframe Display. 

A mainframe session window appears on the Rumba desktop.

Changing the display options
Some of the screens used by the Demo Host can be difficult to see because of the blue text color they use.
The simple solution is to change the color.

To do this:
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1. Select Options > Display. 

The Display Options dialog box appears.
2. Click the Color Attributes tab.
3. In the Multi Color Attributes frame, click the button labeled Protected. 

The color palette appears:

4. Click the light green box. 

The blue Protected button changes to green.
5. In the Extended Color Attributes frame, click the button labeled Blue. 

The color palette appears:

Getting Started | 9



6. Click the light green box. 

The blue button changes to green.

7. Click OK. 

All dark blue text on screens will now appear as green.

Configuring the connection to the Demo Host
1. Select Connection > Configure. 

The Connnection Configuration window appears:

2. In the Auto Connection Options frame, check Auto Connect.

3. In the Installed Interfaces frame, select Demo Host from the list.

4. Click OK.

5. Select File > Save session Profile As. 

The Save Session Profile dialog box appears.

6. In the File name field, type DemoHost.

7. Click OK. 

The Connnection Configuration window closes.
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Creating a History File
Before you start customizing screens, you need to capture a set of screens in a history file. This section
describes how to record a sequence of screens to use in the Screen Designer.

Recording history
You need to create a history file so you have a set of screens to use in the Screen Designer. To do this:

1.
Click the History icon  on the Rumba toolbar. 

The History pane appears.

2.
Click the Record icon  on the History pane toolbar.

3. Select Connection > Connect. 

The Demo Host mainframe session starts:

4.
You must capture the first screen manually. To do this, click the manual capture icon  on the
History pane toolbar. 

The screen appears in the History pane.

The rest of the screens will be captured automatically.

5. At the ENTER SYSTEM ID : prompt, enter: 

TSOA

6. At the ENTER LOGON ID: prompt, press ENTER.

7. At the LAST SYSTEM ACCESS prompt, press ENTER.

8. At the READY prompt, enter: 

TOYS

9. At the TOPCO TOYS, INC screen, press ENTER.
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10.Enter O.

11.At the CUSTOMER SCREEN, press PF8.

12.At the DETAIL LINE ENTRY SCREEN, press ENTER.

13.At the READY prompt, enter: 

E

14.At the TOP OF DATA screen, press ENTER.

15.At the READY prompt, enter: 

R

16.At the TOPCO TOYS, INC screen, press PF3.

17.At the READY prompt, enter: 

A

18.At the EXTEND ATTRIBUTE TEST screen, press PF3.

19.At the READY prompt, enter: 

C

20.At the EUROPEAN CUSTOMER LIST screeen, press PF1.

21.
Click the Record icon  again to stop recording history.

Each screen has been added, in sequence, to the History pane:

Recording a single screen
You can also record screens one at a time. To do this:

1. At the READY prompt, enter: 

Q

2.
Click the Manual capture icon  on the History pane toolbar. 

The screen is added to the list of screens in the History pane.
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Saving the history to a file
To save the recorded history to a file:

1.
Click the Export history to file icon on the History pane toolbar. 

The History Export dialog box appears.

2. Navigate to where you want to save the history file.

3. In the File name field, type DemoHistory.

4. Click Save. 

You now have a number of screens to use in your customization project.

5.
Click the History icon  on the Rumba toolbar. 

The History pane closes.

6. Select Connection > Disconnect.
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Opening the Screen Designer
To open the Screen Designer, do one of the following :

• On the menu bar, select Rumba+ > Open Screen Designer.
•

On the toolbar, click the Open Screen Designer icon .
•

On the History pane toolbar, click the Customize captured screens .

The Screen Designer window appears, with two tabbed pages, the Screen Design page and the Rule
Manager page.

The project toolbar

Start a new project.

Open an existing project.

Save a project.

Save a project with a different name.

Toggle the grid.

Toggle between screen customization and screen identification modes.

Select a theme.

Import history.

Generate a customization file.

Close the Screen Designer.
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The Screen Design page

Screen Designer tabs and toolbar.

History pane. Contains thumbnails of all the screens recorded in the imported history file.

Work area. Contains a full size version of the selected thumbnail. Shows the controls
associated with the screen.

Control panel. Contains a list of available controls that can be applied to the screen in the
work area.

Property grid. Contains a list of available properties for the selected control.

Cursor location. Displays the coordinates of the cursor. Useful when looking for coordinates of
fields.

The Rule Manager page
For information about the Rule Manager and when to use it, see Using the Rule Manager.
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Starting a New Project
1. Click the New project icon  on the project toolbar.

2. Click the Save Project icon  on the project toolbar. 

The Save Rumba+ Project dialog appears.

3. In the Name field, type a name for your project, such as DemoHost, then click Save.
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Importing History

1. Click the Import History icon  on the project toolbar. 

The History Import dialog box appears.

2. Choose your history file, then click Open. 

Thumbnails of the recorded screens appear in the history pane. Each screen has a unique screen ID,
generated by Rumba. It can also have a screen name which you set up using the screen identification
feature. The first screen is selected by default and a larger version of it appears in the work area:

3. Click the Save Project icon  on the project toolbar. 

Note: It is always good practice to save your project after you have some changes to it.
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Selecting a Theme
A theme defines the layout of the screen and the look of each control across all screens in a customization
project.

It is best to choose a theme early in the customization project.

To select a theme:

1. Click the Select a theme icon  on the project toolbar. 

The Choose Rumba+ theme dialog box appears.

2. Select the last thumbnail, Rumba+ Windows Theme.

3. Click OK. 

The theme is applied to all the screens in your project.

For more information about themes, see Using themes.
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Adding Controls
You will now use the Screen Design page to add controls to your screens.

The Screen Design page is used to add controls to specific screens. To add controls that repeat on
multiple screens or many times on a single screen, you use the Rule Manager. For information about the
Rule Manager, see Using the Rule Manager.

As you go through this section, you add controls to your captured screens progressively. We recommend
that you add the controls in the order they are described to build a completed project.

Adding a Button control
Button triggers an action or a sequence of actions when clicked.

1. Ensure the first thumbnail is selected.
2. Drag the Button control icon from the control panel on to the work area and drop it on the far right of the

ENTER SYSTEM ID: row: 

Note: When you drop the control on the screen, the property grid is populated.

3. In the property grid, click in the Caption field and delete the text Button.

4. Type ENTER. 

When you click elsewhere on the screen, the text changes on the control:

5. Click in the Tooltip field and type Sends ENTER key. 
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6. Click the accelerator button  next to the Actions field. 

The Actions dialog box appears:

7. Under Select type, select Emulation Command from the drop-down list.

8. Click Add. 

A new action appears in the Actions frame and its properties appear in the Properties frame.

9. In the Properties frame, select Enter from the drop-down list: 

10.Click OK.

11.Click the Save icon  on the project toolbar.

Adding a Chooser control
Chooser appears on the screen like a drop-down list. Chooser is used to insert data into a field on the
screen by selecting an item from the list.

1. Drag the Chooser control icon from the control panel on to the work area and drop it next to ENTER
SYSTEM ID: 
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2. In the property grid, click the accelerator button  next to Chooser items. 

The Chooser Items dialog box appears:

3. Click the Add button .

4. In the Properties frame, type Select System in the Caption field.

5. In the Tooltip field, type Select system. 

This text will appear as you hover over the selection. Tooltip text can be used for tips and helpful
information on the selection.

6. Leave the Value to Insert field empty.

7. Click the Add button .

8. In the Properties frame, type WYLBUR in the Caption field.

9. In the Tooltip field, type Select WYLBUR.

10.In the Value to Insert field, type WYL. 

This is the text that will be placed in the entry field and must match the commands you would normally
manually type in the field.

The Chooser Items dialog box looks like this:
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11.Repeat the above steps to add the following Chooser items: 

Caption Tooltip Value To Insert

TSO MVS/XA Select TSO MVS/XA TSOA

TSO MVS/XB Select TSO MVS/XB TSOQ

VM/370 Select VM/370 VM

When complete, the Chooser Items dialog box looks like this:

12.When you have finished, click OK.

13.Use the handles on the control to size so that the text shows correctly. 

Your screen should look like this:
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14.Click the Save icon  on the project toolbar.

Adding a Tooltip control
Tooltip displays text when the mouse hovers over the screen area that Tooltip occupies.

1. Drag the Tooltip control icon from the control panel on to the work area and drop it on top of ENTER
SYSTEM ID:

2. Drag the handles on the control so the control covers the screen text: 

3. In the property grid, type the following in the Caption: 

Use drop-down list to select system

4. Click the Save icon  on the project toolbar.

Adding an AutoExecution control
After you log into Demo Host, you need to press ENTER twice before the READY prompt appears. You can
use an AutoExecution control to automate this sequence. To do this:
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1. In the left pane, select the second screen. 

A larger version of the screen appears in the work area.

2. Drag the AutoExecution control from the control panel and drop it to the right of the Rumba icon: 

3. In the property grid, click the accelerator button  next to the Actions field.

4. From the Select type list, select Emulation Command. 

5. From the Action list, select Enter:

6. Click OK.

7. Select the third screen in the left pane:

8. Add another AutoExecution control and give it the same properties: 
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9. Click the Save icon  on the project toolbar.

Adding an Image control
Image masks an area of a screen with either a color or an image.

Note: In this section you use the welcome.jpg file supplied with this document.

1. In the history pane, scroll down and select the fourth thumbnail. This shows the READY prompt. 

A larger version of the screen appears in the work area:

2. Drag the Image control icon from the control panel onto the work area, then size it to 15x66: 

Adding Controls | 25



3. In the property grid, select Image from the Type drop-down list. 

The ImagePath field appears.
4. Click the accelerator button  next to the ImagePath field. 

The Open dialog box appears.
5. Navigate to where you have saved the welcome.jpg file, select the file, and click Open. 

The selected image now fills the control on the screen:

6. Click the Save icon  on the project toolbar.

Adding a Label control
This section describes how to change the text of a screen field label so it can be used for something else.
In this case, a date.

1. In the history pane, select the SALES ORDER ENTRY - CUSTOMER SCREEN. 

A larger version of the screen appears in the work area.
2. Drag the Label control icon from the control panel on to the work area and drop it on top of the

Contract field.
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3. Size the control so it covers the field completely: 

4. In the property grid, uncheck HostText. 

The LabelText field appears.

5. In the LabelText field , delete the default text Label and type Date:

6. Check OverrideColorsSettings. 

The control now uses the screen background and foreground colors for the label background and the
text. The label text is now visible in the control:

7. Click the Save icon  on the project toolbar.

Adding a Calendar control
Calendar inserts a selected date at a specified point on the screen.

1. Ensure the SALES ORDER ENTRY - CUSTOMER SCREEN screen is still displayed in the work area.

2. Drag the Calendar control icon from the control panel on to the work area and drop it to the right of the
(new) Date field: 
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3. In the property grid, in the Inserted Date Format field, select MM/dd/yy from the drop-down list.

4. In the Tooltip field, type Select date

5. Click one space to the right of the Calendar control. 

The coordinates of the screen location appear in the status bar, below the property grid. In this case,
3,52.

6. In the property grid, delete the 0 in the Insert Row field, then type 3.

7. Delete the 0 in the Insert Column field, then type 52.

8. Click once in the TextInsertionLocation field. 

When complete, the property grid page looks like this:

9. Click the Save icon  on the project toolbar.

Adding a GridCollector control
GridCollector gathers information from a specific screen location and displays the information in a table.

1. In the left pane, scroll down and select the EUROPEAN CUSTOMER LIST screen. 

28 | Adding Controls



2. Drag the GridCollector control from the control panel and drop it at the start of the first row: 

3. Click the Edit icon  on the control. 

The GridCollector frame appears:
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4. Move and size the GridCollector frame so that it overlays the screen data: 

5. In the property, in the Name field, delete GridCollector and type CustomerList.

6. Click the accelerator button  next to the Columns field. 

The Columns dialog box appears:
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7. In the Name field, delete GridCollectorColumn, and type Account.

8. Click the Add button . 

Another item appears in the Column Items frame.

9. In the Name field, type Sales Rep.

10.Click the Add button . 

Another item appears in the Column Items frame.

11.Continue to add columns for:

• Vol/Yr

• Cum Rev

• Country

The dialog box should loook like this:

12.Click OK. 

The GridCollector frame now contains a number of blue vertical lines. These represent column dividers.

13.Drag each column divider to the left of each column. 

The GridCollector should look like this:

Tip: In some cases, such as Web applications, system parameters do not look for leading spaces.
It is therefore best to start a column on the first character of data.
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14.At the top right of the GridCollector, click the Save icon .

15.Click the Save icon  on the project toolbar.

Adding a Table control
This section describes how to add a Table control and link it to the GridCollector control.

1. Drag the Table control from the property grid and drop it on the GridCollector control. 

The table automatically links to the GridCollector control and maps on to the area defined by the
GridCollector.

Note: The LinkedGridCollectorName field in the property is completed automatically, and the
table header and columns properties are taken from the linked GridCollector properties.

2. Uncheck IsAutoNavigateOnLoad.

3. Uncheck IsMoreButtonVisible.

4. Click the Save icon  on the project toolbar.

Adding a Collector control
Collector controls gather screen data for use in other functions. In this case you will add a Collector control
to collect data to generate a pie chart for January.

1. In the history pane, select the TOPCO TOYS, INC screen. 

A larger version of the screen appears in the work area.

2. Drag the Collector control icon from the control panel on to the work area and drop it on top of 305 in
the JAN column for region 1.

3. In the property grid, type R1Jtoy in the Global Parameter Name field. 

This is the variable where the value will be referenced.

4. Leave Trim Spaces checked.

5. Add Collector controls for the three other regions. Use R2Jtoy, R3Jtoy, and R4Jtoy as global
parameter names. 

The Screen Design page looks like this:
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6. Click the Save icon  on the project toolbar.

Adding a WebFrame control
In the previous section, you added four Collector controls to collect data for a pie chart. You will now add a
WebFrame control to use the variables of the Collector controls to generate the pie chart.

1. Drag the WebFrame control icon from the control panel on to the work area and drop it just underneath
JAN: 

2. Open the WebFrame_URL.txt file that came with this document. 

The file contains the following URL:

http://chart.googleapis.com/chart?chs=300x150&cht=p3&chco=0000FF|00FF00|
FF0000|FFFF00&chds=0,1000&chd=t:%%R1Jtoy%%,%%R2Jtoy%%,%%R3Jtoy%%,%%R4Jtoy%
%&chdl=Region1|Region2|Region3|Region4&chtt=TOYS

3. Copy the content of the file and paste it in the Target field of the property grid.

4. Click the Save icon  on the project toolbar.
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Adding a Tab control
Tab provides an area of the screen to which you can assign other controls. You can have multiple Tab
controls on a screen, with multiple tab items within a Tab control.

1. In the history pane, select the SALES ORDER ENTRY - DETAIL LINE ENTRY SCREEN. 

A larger version of the screen appears in the work area.

2. Drag the Tab control icon from the control panel to work area and drop it on the Remarks area on the
screen: 

3. In the property grid, click the accelerator button  next to the TabItems field. 

The TabItems dialog box appears:

4. In the Caption field, delete Tab Item and type Order.

5. Click the Add button . 

Another item appears in the Properties frame.
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6. In the Name field, delete Tab Item and type Quantity.
7. Click the Add button . 

Another item appears in the Properties frame.
8. In the Name field, delete Tab Item and type Approved. 

The dialog box looks like this:

9. Click OK. 

The Tab control now as three Tab items:

10.In the property grid, click the down button  next to the Color field. 

The Available Colors palette appears:
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11.Select RoyalBlue: 

The color fills the Tab control and its Tab items:

12.Click the Save icon  on the project toolbar.

Adding an InputField control
InputField provides a text input field in which you type text which is inserted at a specified screen location.

1. An input field requires a label. Drag the Label control icon from the control panel and drop it onto the
Tab control you have created: 

2. In the property grid, uncheck HostText. 

The LabelText field appears.

3. In the LabelText field, delete the default text Label and type Order Number:.

4. Add another Label control below the first and call it Status:.

5. Size both labels: 

36 | Adding Controls



6. Drag the InputField control icon from the control panel and drop it on the Order Number row: 

7. On the green scren, click one space to the right of the Order Number field. 

The coordinates of the screen location appear in the status bar, below the property grid. In this case,
3,16.

8. In the property grid, delete the 0 in the Insert Row field, then type 3.

9. Delete the 0 in the Insert Column field, then type 16.

10.Click once in the TextInsertionLocation field.

11.Check OverrideColorsSettings. 

The Tab item currently looks like this:

12.Click the Quantity tab.

13.Drag the Label control icon onto the tab item.

14.Uncheck HostText and call the label Product Number:.

15.Size the label.

16.Add another label below the first, call it Quantity:, then size it. 

The Tab item should look like this:

17.Add an InputField control on each row with the following specifications: 
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Property First control Second control

InsertionRow 6 8

InsertionColumn 18 18

OverrideColorsSettings Checked Checked

The Tab item should look like this:

18.Click the Approved tab.
19.Uncheck HostText, call the label Approval:, and size the label: 

20.Click the Save icon  on the project toolbar.

Adding a RadioButton control
RadioButton adds text at a specified screen location.

This section uses the Tab control you created previously.

1. Click the Order tab: 

2. Drag the RadioButton icon from the control panel and drop it on the Status: row: 
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3. In the property grid, delete RadioButton from the Caption field and type Open.

4. In the GroupName field, type OrderStatus.

5. In the InsertionRow field, type 3.

6. In the InsertionColumn field, type 33.

7. In the TextToSend field, type Open. 

The property grid should look like this:

8. Drag the RadioButton icon from the property grid and drop it below the Open radio button: 

9. In the property grid, delete RadioButton from the Caption field and type Shipped.

10.In the GroupName field, type OrderStatus.

11.In the InsertionRow field, type 3.

12.In the InsertionColumn field, type 33.

13.In the TextToSend field, type Shipped. 

The Tab item should look like this:

14.Click the Save icon  on the project toolbar.

Adding a CheckBox control
CheckBox acts like an on/off toggle in the same way as a typical check box.

This section uses the Tab control you created previously.

1. Click the Approved tab: 
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2. Drag the CheckBox icon from the control panel and drop it on the Approval: row: 

3. In the property grid, delete CheckBox in the Caption field and type Approved.

4. In the CheckedValue field, type Approved.

5. In the UncheckedValue field, type Pending.

6. In the InsertionRow field, type 5.

7. In the InsertionColumn field, type 57. 

The property grid should look like this:

The Tab item should look like this:
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Exporting a Customization File
You must now export all the controls and rules you have created to a customization file. You will then link
the file to a mainframe session.

To generate the customization file:

1. Click the Export customization file icon  on the project toolbar. 

The Save Rumba Designer Archive dialog appears.

2. In the File name field, type a name for the file, such as DemoHost.

3. Click Save.
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Closing the Screen Designer
To close the Screen Designer, click the Exit customization icon on the project toolbar.
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Associating the Customization File with a
Host Session

The final step is to associate the customization file a with a host session. To do this:

1. On the Rumba desktop, select Rumba+ > Rumba+ Mode.

2. Select Rumba+ > Settings. 

The Rumba+ Settings window appears.

3. Next to the Associate Rumba Designer Archive field, click Browse. 

The Associate Customization File dialog box appears.

4. Choose the customization file you created, then click Open.

5. In the Rumba+ Settings window, click OK.
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Testing the Screens
1. Select Connection > Connect. 

The mainframe screen appears in Rumba+ mode, showing the controls you added to it:

2. Hover your mouse over ENTER SYSTEM ID: 

The tooltip text you created appears:

3. From the drop-down list, select TSO MVS/XA.

4. Click ENTER. The AutoExecution controls you created send an ENTER command automatically at the
ENTER LOGON ID: and LAST SYSTEM ACCESS prompts, presenting you with the READY prompt
screen and the image you added with the Image control:
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5. At the READY prompt, enter: 

O

The SALES ORDER ENTRY CUSTOMER SCREEN appears:

This screen contains the Date label and Calendar control you created:

6. Hover your mouse over the Calendar control. 

The tooltip text you entered appears:

7. Click the Calendar control. 

A calendar appears:
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8. Select today's date, then click Set Date. 

The date appears:

9. Press PF3.

10.At the READY prompt, enter C. 

The EUROPEAN CUSTOMER LIST screen appears, showing the table you created with the
GridCollector and Table controls:

11.Press PF1.

12.At the READY prompt, enter: 

TOYS

13.At the TOPCO TOYS, INC screen, press ENTER.

14.Click the WebFrame control under JAN. 

The pie chart you created appears in a separate window:
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15.Close the pie chart window.

16.In the TOPCO TOYS, INC screen, press ENTER.

17.At the READY prompt, enter: 

O

The SALES ORDER ENTRY CUSTOMER SCREEN appears.

18.Press PF8. 

The SALES ORDER ENTRY DETAIL LINE ENTRY SCREEN appears, showing the Tab control you
created:

19.On the Order Tab item, in the Order Number field, type 12345. 

The number appears in the Order Numberfield on the green screen.

20.Select the Open radio button. 

The text Open appears in the Status field next to the order number.

21.Select the Shipped radio button. 

The text Shipped replaces Open in the Status field:

22.Click the Quantity tab.

23.In the Product Number field, type ABC77701. 

The text appears in the Product Number field.

24.In the Quantity field. type 25. 

The text appears in the Order Qty field:
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25.Click the Approved tab.

26.Select the Approved check box. 

The check box is unchecked and the text Pending appears in the second Status field.

27.Check Approved. 

The check box is checked and the text Approved appears in the second Status field.

The screen looks like this:

28.Select Connection > Disconnect.
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Reference
This section contains additional, reference information about the Screen Designer, controls, and rules.

Controls

AutoExecution
AutoExecution is used to trigger a sequence of actions when a green screen appears. The control is
invisible at run time. Only one AutoExecution control is allowed per screen.

Properties:

Name Default value Description

Actions Empty list One or many actions are executed
sequentially from the top to the
bottom in the specified list.

Button
Button is used to trigger a sequence of actions when clicked. The control can include text or an image.

Properties:

Name Default value Description

Mode Text Specifies the type of content for the
control. Can be Text or Image.

Caption Button The text to be displayed on the
button.

ImagePath Queston mark (?) The image to be display ed on the
button.

ImagePosition Stretch Specifies the position of the image
inside the button:

Stretch (default)
Fill
Fit
Center

Tooltip The tool tip is displayed when the
mouse pointer hovers over the
button.

If empty, the button’s caption is
displayed.

Actions Empty list One or many actions which are
executed sequentially from the top to
the bottom in the specified list.

Style Default The button style,
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Name Default value Description

OverrideStyleSettings Unchecked When checked, the background and
foreground color options are made
available, overriding the Style
property.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen text color is used as
the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used s
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Calendar
Calendar is used to pick a date and is initially displayed on the screen as an icon. Calendar opens when
you click the icon. It closes on losing focus, or when you click Set Date or Cancel.

When you click SetDate, the text presenting the date is inserted into the TextInsertionLocation
(InsertionRow, InsertionColumn) according to the InsertedDateFormat.

If the field occupied by Calendar contains date, the field is used by Calendar when it opens. Otherwise,
Calendar uses the current date.

Properties:

Name Default value Description

TextInsertionLocation (0,0) The (row,column) where the value of
the control is inserted on the screen.
0 means the location of the control as
specified on the Screen Design
page, or the location of the logical
marker defined by the SearchFor
condition.

InsertionRow 0 Specifies a row, where the inserted
date text begins on the screen. Zero
means the location of the control as
specified on the Screen Design
page, or the location of the logical
marker defined by the SearchFor
condition.

InsertionColumn 0 Specifies a column, where the
inserted date text begins on the
screen. Zero means the location of
the control as specified on the
Screen Design page, or the location
of the logical marker defined by the
SearchFor condition.
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Name Default value Description

InsertedDateFormat Empty string Specifies the format of the text
representing the date format.

If empty, the default date format is
used:

MM/dd/yyyy hh:mm:ss

For example, 09/21/2012
12:00:00.

Tooltip Empty string If empty, no tool tip is displayed.

CheckBox
The CheckBox control acts as an on/off toggle control in the same way as a typical check box.

CheckBox provides the user a method of choosing between two options, such as Yes and No.

Properties:

Name Default value Description

TextInsertionLocation (0,0) The (row,column) where the value of
the control is inserted. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

InsertionRow 0 The row where the inserted text
begins on the screen. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

InsertionColumn 0 The column where the inserted text
begins on the screen. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

CheckedValue Empty string The value that will be used at the text
inserted at the specified screen
location, if the check box is checked.

UncheckedValue Empty string The value that will be used at the text
inserted at the specified screen
location, if the check box is
unchecked.

Caption Check Box The label text that appears next to the
check box.

Tooltip Empty string The tool tip text that appears when
the mouse hovers over the control.

OverrideStyleSettings Unchecked When checked, the background and
foreground color options are made
available which, when selected,
override the Style property.

Background UseBackgroundFromHost A list box containing two options:
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Name Default value Description

• UseBackgroundFromHost (the
host screen background color is
used as the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used as
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

BackgroundColor Black A color palette for choosing the
background color. Only available if
Background is set to
CustomColors.

ForegroundColor White A color palette for choosing the text
color. Only available if Foreground is
set to CustomColors.

Chooser
Chooser is displayed on the screen as a drop-down control. Chooser is used to insert data into a field on
the screen by selecting an item from the list.

Auto-complete is supported.

Properties:

Name Default value Description

TextInsertionLocation (0,0) The (row,column) where the value of
the control is inserted on the screen.
0 means the location of the control as
specified on the Screen Design
page, or the location of the logical
marker defined by the SearchFor
condition.

InsertionRow 0 The row where the inserted text
begins on the screen. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

InsertionColumn 0 The column where the inserted text
begins on the screen. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

ChooserItems Empty list The list of items displayed by the
drop-down list when clicking the down
arrow. The list of items can be
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Name Default value Description

imported from a .csv file (see
below). Each item is specified by
Caption, Tooltip, and
ValueToInsert.

Caption The text to be displayed on the drop-
down list item.

Tooltip The text to be displayed by Tool Tip
when the mouse cursor hovers over
the drop-down list item.

ValueToInsert Specifies the text to be inserted when
selecting an item from the list.

IsAutoCompleteEnabled Checked When checked, Chooser
automatically offers a case-
insensitive matching item to be
selected from the list. If the user is
not typing in the screen field occupied
by Chooser, no suggestions are
made.

IsEditable Checked When checked, data can be typed
into the field that Chooser is using. If
unchecked, data can only be selected
from the drop-down list.

OverrideStyleSettings Unchecked When checked, the background and
foreground color options are made
available, overriding the Style
property.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen text color is used as
the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used s
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Importing items from a .csv file

To use this feature successfully, the contents of the .csv file must be in the following format:

<CAP><DEL><TIP><DEL><VAL>

where:

This ... Denotes this ...

<CAP> Caption.

<DEL> Delimiter (;). This is the only supported delimiter.
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This ... Denotes this ...

<TIP> Tool tip.

<VAL> Value to insert.

For example:

#First block

AAA;BBB;CCC

AAA;BBB;CCC

DDD;EEE;ZZZ

GGG;HHH;III

JJJ;KKK;LLL

MMM;NNN;OOO

To import a .csv file:

1. Click the accelerator button next to ChooserItems in the property grid.
2. In the ChooserItems dialog box, click the Import icon.
3. Select the .csv file.
4. Click OK.

Collector
Collector is a control invisible at run time. It is used to copy text from the Collector’s screen location to the
session database. The Collector’s screen location is defined by the two pairs (Row Offset, Column
Offset), (Row Span, Column Span).

The database lifetime is the whole session. Data is collected when host screen appears as a list of (key,
value) pairs of strings. The data can be used by other controls only from the current session. When the
Collector’s screen location spans screen rows, appropriate line breaks are inserted into the collected data.

For example, a Button control looking like a small handset icon can be set up with an action
Run_Application to run Skype. Additional_Arguments of this action can use a phone number stored by
the Collector located in a phone number field on another screen of the session.

Properties:

Name Default value Description

GlobalParameterName Empty string Specifies a key to be used by
Collector when copying data from the
Collector’s screen location to the
database.

Data stored with the same key more
than once is overwritten.

Data can be accessed later in the
session by using the syntax:

%%PhoneNumber%%

where PhoneNumber is the global
parameter name.

TrimSpaces Checked When checked, whitespace
characters are not copied to the
database. When unchecked,
whitespace characters are included in
the data.
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GridCollector
The GridCollector control is an extended version of the Collector control. Collector collects data as text
from a specific screen location. GridCollector collects data as a table (grid).

The control stores the collected information in a database for the lifetime of the current session. The
information can be used by any other control.

To configure GridCollector properties, click the Edit Mode button at the top right corner of the control.
When you have finished, click either the Save and Exit button or the Cancel Edit Mode button.

Properties:

Name Default value Description

Name GridCollector The name for a GridCollector. Must
be unique.

Columns Columns collection. Each column has
one property:

Name: Non-empty string. The default
name is GridCollector Column.

IncludesHeader Checked When checked, the selection includes
the table header.

AvoidDuplications Checked When checked, duplicate rows are
not collected.

MultiPageNavigation Checked When checked, the following
properties are enabled:

MaxPages
AIDKey
EndCondition

MaxPagesToLookUp 1 Integer. The number of pages that
are fetched each time the Fetch
operation is triggered by one of the
controls that uses the GridCollector
data. The GridCollector implements
the fetching mechanism (not the
control that uses the GridCollector) .

NavigationAidKey PF8 The AID key for fetching the next
page.

EndOfDataCondition

SameData When selected, data collection stops
if duplicate data is found.

EmptyLine When selected, data collection stops
if an empty line is found.

Text When selected, data collection stops
if:

either:

The specified non-empty string is
found at the specified screen location.

or:
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Name Default value Description

The specified string is empty and
nothing is found at the specified
screen location.

EndOfDataText The text to search. Available if Text is
selected.

EndOfDataTextRow The row of the text.

EndOfDataTextColumn The column of the text.

EndOfDataTextLocation Location of the text.

Any control that wants to use the data from the GridCollector can get the data by using the following
syntax:

%%GridCollector_Name[Row_Number,Column_Name]%%

Examples:

%%Customers[5,Address]%% Defines getting the address of the entry 5.

%%Customers[*,Address]%% Defines getting the address of all customers. This can be
useful for setting a list control's items source.

%%Customers[3,*]%% Defines getting all data for the customer at the third row.

%%Customers[*,*]%% Defines getting GridCollector data for all customers.

On a Rumba+ screen, each time new data appears on the screen, the data is added to the GridCollector
table.

Image
Image control is used to mask an area on the screen. It appears at run-time without a frame, and can be
filled with one of the following:

Color If UseBackgroundFromHost is checked, Image is filled with with the host background color. If
UseBackgroundFromHost is unchecked, you can select the fill color from the palette. The
default color is black. If you select a transparent fill, the Image control is invisible on the screen.

Image If you do not specify a path to the image, or the path is not valid, the Image control is invisible on
the screen.

You can change the opacity of the Image control on the Screen Design page to show the contents of the
screen behind the control. To do this, select the control, then click the icon on the top right corner of the
control's frame.

Properties:

Name Default value Description

Type Color Can be either Color or Image.

UseBackgroundFromHost Checked Only available if Type is Color.

Color Black Fill color. Only available if Type is
Color and
UseBackgroundFromHost is
unchecked.

ImagePath Empty string Fully qualified path of an image file.
Only available if Type is Image.
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Name Default value Description

The image URI can be one of the
following:

• Path to file:

An image file with a format of
JPG, GIF, or PNG.

• HTTP:

The Web address of an image.

You can also use the Collector
control to provide the image path.

ImagePosition Stretch Position and size of the selected
image. Can be one of the following:

Stretch (default)
Fill
Fit
Tile
Center

InputField
The InputField control provides a text input field into which the user types text which is inserted at a
specified screen location.

For example, InputField can be used to modernize or rationalize the layout of a screen with a number of
input fields. InputField controls can be placed where they are most useful. The information the user types
into them is then inserted in the screen locations of the traditional editable areas.

Note: When the control is used in a Rumba+ screen, the input field displays the value from the screen
location, at the specified length. However, if the screen location is a protected field, no data is read
and no typing is allowed in the InputField control..

In addition, if the length is 0 (the default value), data is read until the end of the green screen field the
control refers to, and the number of characters is limited by the length of the green screen.

Properties:

Name Default value Description

TextInsertionLocation (0,0) The (row,column) where the text is
inserted on the screen. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

InsertionRow 0 The row where the inserted text
begins on the screen. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

InsertionColumn 0 The column where the inserted text
begins on the screen. 0 means the
location of the control as specified on
the Screen Design page, or the
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Name Default value Description

location of the logical marker defined
by the SearchFor condition.

Length 0 The maximum number of characters
that the input field can contain. A
value of 0 means the number of
characters is limited by the length of
the green screen field.

Tooltip Empty string A tool tip that describes the control.

IsNumeric False Specifies whether the input is
numeric or for al characters.

OverrideStyleSettings Unchecked When checked, the background and
foreground color options are made
available, overriding the Style
property.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen text color is used as
the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used s
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

BackgroundColor Black A color palette for choosing the
background color. Only available if
Background is set to
CustomColors.

ForegroundColor White A color palette for choosing the text
color. Only available if Foreground is
set to CustomColors.

IsPassword Unchecked When checked, an asterisk (*) is used
to masked the typed characters.

Label
The Label control is a single line control which is used to place any static text at a specified location on a
screen.

Properties:

Name Default value Description

HostText Checked When checked, the host text located
at (StartRow,StartColumn) is used
as the label text. When unchecked,
LabelText is made available.
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Name Default value Description

LabelText Label If HostText is unchecked, this
specifies the custom text to be
displayed on the label.

Alignment Left Specifies the alignment of the label
text:

Left
Center
Right

LabelLocation Shows the starting row and column
for the label text. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

See note below.

StartRow 0 Specifies a row, where the label text
begins on the screen.

StartColumn 0 Specifies a column, where the label
text begins on the screen.

Length 0 Length of the content in characters
defines the length of the tool tip on
the screen.

OverrideStyleSettings Unchecked When checked, the background and
foreground color options are made
available, overriding the Style
property.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen text color is used as
the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used s
the foreground color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

LabelLocation: When the emulation screen is loaded, and HostText is checked, the Label control
displays the value from the LabelLocation coordinates.

In addition, you can pick the location’s color preferences and bind them to the Label control. To do
this, the following values must be set:

Property Setting

OverrideStyleSettings Checked.
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Property Setting

Background UseBackgroundFromHost

Foreground UseForegrounfFromHost

RadioButton
The RadioButton control is used to add text at a specified screen location.

Properties:

Name Default value Description

TextInsertionLocation (0,0) The (row,column) where the value of
the control is inserted. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

InsertionRow 0 The row where the inserted text
begins on the screen. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

InsertionColumn 0 The column where the inserted text
begins on the screen. 0 means the
location of the control as specified on
the Screen Design page, or the
location of the logical marker defined
by the SearchFor condition.

Caption RadioButton The text to be displayed on the
control.

Tooltip Empty string The tool tip text that appears when
the mouse hovers over the control.

GroupName Empty string The radio button group this radio
button belongs to.

TextToSend Empty string The text to send to the host.

OverrideStyleSettings Unchecked When checked, the background and
foreground color options are made
available, overriding the Style option.

Background UseBackgroundFromHost A list box containing two options:

• UseBackgroundFromHost (the
host screen background color is
used as the background color)

• CustomColors

Available only if
OverrideStyleSettings is checked.

Foreground UseForegroundFromHost A list box containing two options:

• UseForegroundFromHost (the
host screen text color is used as
the foreground color)

• CustomColors
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Name Default value Description

Available only if
OverrideStyleSettings is checked.

BackgroundColor Black A color palette for choosing the
background color. Only available if
Background is set to
CustomColors.

ForegroundColor White A color palette for choosing the text
color. Only available if Foreground is
set to CustomColors.

Tab
Tab provides an area of the screen to which you can assign other controls. You can have multiple Tab
controls on a screen, with multiple tab items within a Tab control.

To assign a control to a tab item, drag the control on to the appropriate tab item.

When you select another tab item, that tab item is shown, together with its controls.

Notes:

• Deleting a tab item deletes all its assigned controls.
• Deleting a Tab control deletes all its tab items and their assigned controls.

Properties:

Name Default value Description

TabItems Empty collection Lists all tab items and their controls.
Each tab item has a caption.

HostBackground Unchecked When checked, the Tab control uses
the background color of the host
screen. When unchecked, the control
uses the color defined by the Color
property.

Color White Smoke Specifies the background color of the
Tab control.

Table
The Table control formats data from multiple screens as a scrollable table with filtering and sorting
capabilities.

The Table control uses a pre-defined GridCollector control as its data source. If there is already one, single
GridCollector on the screen, the Table control links to it automatically. If there is no GridCollector on the
screen, you must link to a GridCollector manually using the LinkedGridCoillectorName property.

Properties:

Name Default value Description

LinkedGridCoillectorName Name of the GridCollector control to
which the Table control is linked.

Columns Collection of columns.

Title Name of the linked GridCollector
column.

The visible column title.
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Name Default value Description

IsVisible Checked When checked, the control is visible
on a Rumba+ screen.

ColumnAliasInGridCollector Name of the GridCollector column
from where the data will be taken.

ColumnType String Can be one of:

String
Number
Date

ColumnDateFormat Format of dates in the selected
column.

IsHeaderVisible Unchecked When checked, the table shows the
column headers.

IsAutoNavigateOnLoad Checked When checked, the Table control
triggers the GridCollector to fetch the
next pages automatically when the
Table control is activated.

IsFilterable Checked When checked, adds a Filter field to
the table.

IsMoreButtonVisible Checked When checked, the More button is
enabled on the table.

ColumnAlignment Left Aligns the cell text. Can be one of:

Left
Center
Right

DefaultRowCommand Actions performed when the user
double-clicks a row. The syntax for
taking the text from the clicked row is:

##DGC_column_name_linked_
to_the_column##

LinkedGridCollectorName The name of the linked GridCollector
control.

Tooltip
The Tooltip control is activated when the mouse pointer hovers over the screen area that Tooltip occupies.

There are two modes for Tooltip:

Static mode Where the content of Tooltip is a free string. The string can include global collect
variables.

Advanced mode Where Tooltip can read text from screen location and use it as the displayed text.

Properties:

Name Default value Description

Caption Empty string Specifies the text displayed by
Tooltip. Data stored by Collectors can
be used.
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Name Default value Description

Advanced Unchecked When checked, activates advanced
mode.

TooltipItems Advanced mode only.

Tooltip Location Shows the starting row and column
for the Tooltip text..

StartRow 0 Specifies a row, where the Tooltip
text begins on the screen. Advanced
mode only.

StartColumn 0 Specifies a column, where the Tooltip
text begins on the screen. Advanced
mode only.

Importing items from a .csv file

To use this feature successfully, the contents of the .csv file must be in the following format:

<KEY><DEL><TIP>

where:

This ... Denotes this ...

<KEY> Key representing on-screen emulation text.

<DEL> Delimiter (;). This is the only supported delimiter.

<TIP> Tooltip text.

For example:

#Tool Tip values

TSO;TSO log on

Password;Enter your password

Application required;Enter your CICS application name

Userid;Enter your user ID

To import a .csv file:

1. Click the accelerator button next to TooltipItems in the property grid.
2. In the TooltipItems dialog box, click the Import icon.
3. Select the .csv file.
4. Click OK.

WebFrame
Web Frame is an icon which, when clicked, opens a separate window in the default Web browser at a
specified Web address. For example, an icon looking like a small globe can be set to open a map based on
the postal address displayed in the host screen field.

Properties:

Name Default value Description

Target Empty string Any valid Web address. The data
stored by Collectors can be used in
specifying the target.

Icon Empty string Can be one of the following:

Reference | 63



Name Default value Description

• Full path to an image to be used
as an icon.

• Windows XP: Relative path to:

C:\Documents and
Settings\<User>
\Application Data
\Micro Focus\Rumba
\Plus\Icons

Windows Vista, Windows7:
Relative path to:

C:\Users\<User>
\AppData\Local\Micro
Focus\Rumba\Plus\Icons

Width 500 Window width in pixels.

Height 500 Window height in pixels.

Tooltip If empty, no tool tip is displayed.
Otherwise, specifies the text that
Tooltip displays when the mouse
hovers over the WebFrame icon.

Shared properties
Each of the following properties may be used by more than one type of control:

Name Default value Description

ControlTarget RumbaMainArea The control target is the region
specified in the currently selected
theme, where the control is placed.
RumbaMainArea is the region
occupied by the green screen.

Style Empty string Style defines the look of a control. Its
possible values are displayed in the
list of items taken from the currently
selected theme. If not specified, the
default style is used.

UseBackgroundFromHost Unchecked When checked, a control acquires its
background color coming from host.
When unchecked, the background
color defined by the control’s style is
used.

UseForegroundFromHost Unchecked When checked, a control acquires its
foreground color coming from host.
When unchecked, the foreground
color defined by the control’s style is
used.

RowOffset 0 Vertical offset relative to the row
where the logical marker is located.
Logical markers are defined by the
SearchFor condition. A positive or
negative value defines the screen
location as the number of rows down
or up the logical marker.
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Name Default value Description

A wrong offset value can adversely
displace the control.

ColumnOffset 0 Horizontal offset relative to the
column where the logical marker is
located. Logical markers are defined
by the SearchFor condition. A
positive or negative value defines the
screen location as the number of
columns from the right or left of the
logical marker.

A wrong offset value can adversely
displace the control.

RowSpan 0 If not zero, overrides the height of a
logical marker defined by the
SearchFor condition.

ColumnSpan 0 If not zero, overrides the width of a
logical marker defined by the
SearchFor condition.

Actions
Action Description Values

SetText Inserts text into the specified screen
location of an unprotected field.

If the specified location is not in any
unprotected field, no action is
performed.

InsertionRow A row, where
the inserted
text begins on
the screen. 0
means the
location of the
control as
specified on
the Screen
Design page,
or the location
of the logical
marker defined
by the
SearchFor
condition.

InsertionColumn A column,
where the
inserted text
begins on the
screen. 0
means the
location of the
control as
specified on
the Screen
Design page,
or the location
of the logical
marker defined
by the
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Action Description Values

SearchFor
condition.

ActionTarget The text to be
inserted.

EmulationCommand Runs the emulation command. EmulationCommand Possible
values are
shown in a
list.

WebSite Runs the user’s default browser to
navigate to a specified Web site.

ActionTarget Web site address.
Data stored by
Collectors can be
used to specify
arguments.

RunApplication Run a specified application on the
user's machine.

ActionTarget Command
line to run.
Data
stored by
Collectors
can be
used to
specify
arguments.

AdditionalArguments Application
arguments.

RunMacro Runs a specified macro with the
Rumba Engine.

ActionTarget Full path to the
macro file to run, or
the path relative to
the Rumba macros
folder. Data stored
by Collectors can
be used to specify
arguments.

RunScript Runs a specified script with the
Rumba Script Engine.

ActionTarget Full path to the
script file to run, or
the path relative to
the Rumba scripts
folder. Data stored
by Collectors can
be used to specify
arguments.

Email Sends an email to a specified
address.

Action
Target

The recipient’s
email address.
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Identifying screens

About screen IDs and names
A screen ID is a numeric identifier, calculated from screen properties by the Rumba engine. Unfortunately,
a screen ID might not be unique.

To ensure that a screen can be identified uniquely, you can select one or more text portions on the screen,
which then distinguishes the screen uniquely across a session.

Based on the screen ID and on the text portions selected on the screen, Rumba automatically generates a
screen name. You can change the name if you want. This name is applied to all screens with the same ID,
and with the same selected text portions across all sessions.

When working on your customization project, it is therefore important to follow these guidelines:

1. First, check that the screen names are unique. If they are not unique, select more text portions on the
screens with the same name to differentiate between them.

2. Avoid renaming screens which are used by different customization projects.

Changing text selections
If you change the text selections on a screen, all the rest of the screens, which have the
same name, will have their names removed. You must therefore be careful if you change
text selections on screens.

Renaming screens
If you rename a screen in one of your customization projects, be aware of the side effect
the change might have on other projects using screens with the same name.

Using screen history
If you use Rumba screen history, you might see some captured screens automatically use
names you have used in a customization project. This happens when a captured screen
has the same ID, and the same selected text portions you have defined in your
customization project.

Creating text selection
1. Open the screen by selecting its thumbnail in the left pane.

2. Click the toggle button on the project toolbar to switch to screen identification mode.

3. Select the text portion on the screen by drawing a rectangular border within a single screen row with a
mouse.

Removing text selection
1. Open the screen by selecting its thumbnail in the left pane.

2. Click the toggle button on the project toolbar to switch to screen identification mode.

3. Right-click the selection, then select Remove This Selection from the pop-up menu. 

Alternatively, you can click the selection to highlight it, then press DELETE.

Naming screens
1. Open the screen by selecting its thumbnail in the left pane.
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2. Click the toggle icon on the project toolbar to switch to screen identification mode. 

3. Specify the screen name as the value of the Screen Name property in the property grid.

Note: We recommend you give each screen in a session a unique name.

Using themes
A theme defines the layout of the screen and the look of each control across all screens in a customization
project.

The screen layout is defined as having a rectangular main area in the center, which might be surrounded
by rectangular areas (margins).

The following themes are included in Rumba:

• Rumba Green Screen
• Rumba+ Green Screen
• Rumba+ Windows

The main area of a screen can contain any type of control. However, margins can contain only buttons.
Margins are defined by the theme you use.

If you change a theme, the margins of the previous theme disappear, together with all the button controls
they contain. It is therefore best to choose a theme early in the customization project.

Using the Rule Manager
Use the Rule Manager to add controls that repeat on multiple screens or many times on a single screen.

The Rule Manager page

Screen Designer tabs and toolbar.

Control panel. Contains a list of the following actions:

New Rule Opens the Rule Wizard to create a new rule.

68 | Reference



Edit Rule Opens the selected rule in the Rule Wizard for editing.

Delete Rule Deletes the selected rule.

Enable Rule Enables the selected rule, if disabled.

Disable Rule Disables the selected rule.

Duplicate Rule Creates a copy of the selected rule.

List of rules pane. Contains a list of configured rules. Each rule consists of:

• A description.
• An icon to show whether the rule is enabled 
•

An icon to show whether the rule is disabled 
•

An icon to edit the rule 
•

An icon to delete the rule 

Rule description pane. Displays a natural language version of the rule.

The Rule Wizard
The Rule Wizard help you to define rules and conditions that govern what actions occur on a screen ad
when.

Steps pane. Contains the steps you need to go through to create a rule. The current step is
highlighted.

Options pane. Contains the options available for the selected step:
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When this step is highlighted ... The options pane contains ...

Step 1 A list of templates that you can use to build
a rule.

Step 2 Conditions that identify the screen the rule
will apply to.

Step 3 The field, location, or text to look for on the
screen.

Step 4 The controls to create according to the rules.

Step 5 Exceptions to the rules that select screens.

Rule description pane. Contains a natural language version of the rule.

The Rule Wizard also contains the following command buttons:

Click this ... To do this ...

Cancel Close the Rule Wizard without saving any changes.

Back Go back to the previous step.

Next Go to the next step.

Finish Finish creating the rule and return to the Rule Wizard main screen.

When to use the Rule Manager
The following basic scenarios describe when to use the Rule Manager instead of the Screen Design page.

• Adding Tooltip or Button controls to entire applications.

Fields with specialized Tooltip controls or assistance which remain consistent within the application.
Especially useful to explain account, customer, and status information that is abbreviated or appears in
abbreviated form on the screen.

Buttons such as Exit, Clear (screen), and Reset (keyboard).
• Adding controls to screens within subsystems.

Controls which are consistent with major subsystems such as accounts payable, help ticket systems, or
customer lookup. A subsystem might consist of five to ten screens, but operator functions are
consistent throughout.

Screen content can change, but header information needs to offer similar modernization control.
• Data scroll areas with modernizations that repeat on each line.

One Rumba+ rule can generate multiple modernizations.

Tip: If you find that a control on the Screen Design page might be used better as a rule, right-click
the control and select Move to Rule Manager from the pop-up menu. The Screen Designer
moves the control to the Rule Manager where you can edit it.

Adding Tooltip or Button controls to entire applications
A simple system Clear button is designed with a rule that places it on every screen of the application in the
top right corner.

Button controls like this help users who are not used to the rules that apply to 3270 / 5250 protocols.
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Adding controls to screens within subsystems
In this example, the administrator wants to help users identify an account status. Anywhere in the
application where the string ACCOUNT STATUS : AB appears, a tooltip appears so that the operator
knows that the account status is active with credit approved.

The rule first finds the character string, then places a tooltip over the entire string. Moving the mouse over
the abbreviated field provides in a more detailed description.
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Adding rules to be used on a set of screens
This example shows three screens in an application called Master Inquiry. The screens are similar, but
have different input prompts and different data headings. Each screen would be identified automatically as
a different screen.

The example creates a rule that puts a Create New Customer button near the first entry field.

The rule for this button is based on the Master Inquiry screen designation. If the screen identifies itself as
Master Inquiry and the string 5=display is found, the rule automatically puts a button by the
5=display field. On screens that do not match the criteria, no button is created. The button is
programmed with the keystrokes to initiate the creation of a customer record within the application.
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Adding controls to each line on a screen
This example uses screens containing tables of data and adds the same controls to each line on the
display. If you were to use the Screen Designer page you would need to add a separate control for each
line of each table. However, instead, you can use rules to replicate controls on each line.
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To select a customer, the user types 1, then presses ENTER. The example sets up a rule that replaces
these actions.

Note: The number of data entries per page varies. The rule creates 10 static selections per page. As
a result, the last page will only have three buttons because only three selections are valid.
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The rule looks for the character strings Select Customer and 1 Select. It then replaces the single
character input field with a button labeled SEL. This button replaces the two actions of typing 1 in the data
field and pressing ENTER with a simple point and click.

Because the rule looks for the input field, if that input field is not found, the control is not added to the
screen.
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Using Web components in Rumba
Rumba can call both applications and Web components using one or more of the following controls:

Button A labeled UI control. It can call an application, script, URL, or Web page.

WebFrame Creates an icon using an image. You can set the size of the frame. Only valid for Web
browser URLs. No address bar is displayed.

Passing parameters to an application or Web page
You pass parameters to an application or Web page using the Collector control. Collector is placed over
the data fields that Rumba+ uses to capture data. When the application runs, there is nothing to show on
the screen that indicates this is a data collection field.

You add Collector controls on the Screen Design page:

Note: The Collector control should cover the entire data field to accommodate long strings.

When you configure a Collector control, you give it a global parameter name in the property grid. This
name must be unique in the customization file. You can refer to the data stored in the parameter as %
%Parameter Name%%. In the figure above the Global Parameter is MapCity and its reference is %
%MapCity%%.

The Trim Spaces property resizes the length of the data string by removing trailing spaces. In most
applications, this option should be True.

Creating Web objects and URLs
The first thing to do is to create a working URL using a known set of parameters for a known address. For
example, this Google Maps parameter is for an Office Park in Maryland:

http://maps.google.com/maps?q=700 King Farm,Rockville,MD

Copy the working URL to an editor such as Notepad so you can edit it for use in the Screen Designer. For
example, the following string re-creates the address string:

%%MapAddr%%,%%MapCity%%,%%MapState%%
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Note that the commas (,) used as delimiters in the Google command, are still in place in the Rumba+
string. The command to copy and paste into the Screen Designer is:

http://maps.google.com/maps?q=%%MapAddr%%,%%MapCity%%,%%MapState%%

As the character strings get more complex, testing becomes more important. For example, the following
string calls a Google charting facility for a pie chart. Notice that the original URL contains a section that
deals with both chart labels (AREA-A,etc) and chart data (T=:100,300,200,50). Other editable data
includes colors, format, and sizing:

http://chart.googleapis.com/chart?chs=300x150&cht=p3&chco=0000FF|00FF00|FF0000|
FFFF00&chds=0,1000&chd=t:100,300,200,50&chdl=AREA-A|AREA-B|AREA-C|AREA-D&chtt=TOYS

As in the Google Maps example, we need to replace the data portion of this URL with variables collected
from the Rumba+ screen. In this case, the data portion (specified by chd), becomes:

chd=t:%%R1Jtoy%%,%%R2Jtoy%%,%%R3Jtoy%%,%%R4Jtoy%%

And the new URL to include in the Screen Designer becomes:

http://chart.googleapis.com/chart?chs=300x150&cht=p3&chco=0000FF|00FF00|
FF0000|FFFF00&chds=0,1000&chd=t:%%R1Jtoy%%,%%R2Jtoy%%,%%R3Jtoy%%,%%R4Jtoy%
%&chdl=Region1|Region2|Region3|Region4&chtt=TOYS

In a real application, you might also want to modify the label data dynamically as well. A label section might
therefore look like this:

chdl=%%Label1%%|%%Label2%%|%%Lable3%%|%%Lable4%%

You can experiment with the Google pie chart URL using the TOYS screen on the Rumba Demo Host. For
information about connecting to the Demo Host and accessing the TOYS screen, see Connecting to the
Demo Host.

Exporting a customization file to Rumba+ Web and
Rumba+ Mobile

The Rumba+ Server Build Tool allows you to build Rumba+ Web and Rumba+ Mobile application
deployment packages.

The tool uses the customization output from the Rumba Screen Designer to create a Web Application
aRchive (.war) file. The .war file contains a rules file and other resources, such as images, macros, and
scripts.

The file is then deployed to an application server for implementation.

Note: The Rumba+ Server Build Tool is supplied with Micro Focus Rumba+ Web and Micro Focus
Rumba+ Mobile.

Exporting a customization file
For information about exporting a customization file, refer to the Rumba+ Server Build Tool 1.1: Help.

Deploying a .war file
For information about deploying a .war file to an application server, refer to the Rumba+ Server 1.1:
Administrator Guide.
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Contacting Micro Focus
Micro Focus is committed to providing world-class technical support and consulting services. Micro Focus
provides worldwide support, delivering timely, reliable service to ensure every customer's business
success.

All customers who are under a maintenance and support contract, as well as prospective customers who
are evaluating products are eligible for customer support. Our highly trained staff respond to your requests
as quickly and professionally as possible.

Visit http://supportline.microfocus.com/assistedservices.asp to communicate directly with Micro Focus
SupportLine to resolve your issues or e-mail supportline@microfocus.com.

Visit Micro Focus SupportLine at http://supportline.microfocus.com for up-to-date support news and access
to other support information. First time users may be required to register.

Information needed by Micro Focus SupportLine
When contacting Micro Focus SupportLine, please include the following information, if possible. The more
information you can give, the better Micro Focus SupportLine can help you.

• The name and version number of all products that you think might be causing an issue.
• Your computer make and model.
• System information such as operating system name and version, processors, and memory details.
• Any detailed description of the issue, including steps to reproduce the issue.
• Exact wording of any error messages involved.
• Your serial number. To find this number, look in the subject line and body of your Electronic Product

Delivery Notice e-mail that you received from Micro Focus.

Additional information needed by Micro Focus
SupportLine

If reporting a protection violation, you might be asked to provide a dump (.dmp) file. To produce a dump
file, use the Unexpected Error dialog box that is displayed when a protection violation occurs.

Unless requested by Micro Focus SupportLine, leave the dump setting as Normal (recommended), click
Dump, then specify a location and name for the dump file. Once the dump file has been written, you can e-
mail it to Micro Focus SupportLine.

You may also be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a tracing
infrastructure that enables you to quickly and easily produce diagnostic information detailing the operation
of a number of Micro Focus software components.
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Tell Us What You Think
We welcome your feedback regarding Micro Focus documentation.

Send feedback about this Help documentation.

Click the above link to email your comments to Micro Focus.
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